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プログラ ミ ング ・ ユーテ ィ リ テ ィ
第 15 章 　 プログラ ミ ング ・ ユーテ ィ リ テ ィ

15.1 デプロ イ メ ン ト ・ ツール （Deployment Tool）
　 デプロ イ メ ン ト ・ ツールはフ ァ イル変換ユーテ ィ リ テ ィ です。 デュ アルブー ト / マルチブー ト 機能対応で
外付け SPI フ ラ ッ シ ュ メ モ リ ーに書 く mcs フ ァ イル （”PROM フ ァ イル ”） を生成する場合や、 書き込みフ ァ
イル （.jed、 .bit） を組み込みコ ン ト ローラが扱 う フ ァ イル ・ フ ォーマ ッ ト に変換する場合、 或いは ECP5 フ ァ
ミ リ ーや Crosslink フ ァ ミ リ ーが対応する Dual-/Quad-SPI フ ラ ッ シュ メ モ リ ー ・ イ ン ターフ ェ イ ス を用いた
り 、 またチェ イ ンを構成する場合など、 種々のケースで用います。

15.1.1 デプロ イ メ ン ト ・ ツールの起動

　 デプロ イ メ ン ト ・ ツールの起動は、 デタ ッチし たプロ グ ラマーから [Design] → [Utilities] → [Deployment
Tool] と選択し ます （図 15-1、 左）。 または Windows の Start メ ニ ューから Lattice Diamond 3.12 を展開する と   
表示される [Deployment Tool] を選択し て も起動でき ます （図 15-1、 右）。

図 15-1. デプロ イ メ ン ト ・ ツールの起動

図 15-2. デプロ イ メ ン ト ツール起動後 と フ ァ ン ク シ ョ ン タ イプ
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　 起動後の初期画面は図 15-2 のよ う にな り ます。 「Function Type」 と し て四つが選択でき、 それぞれに対す  
る生成フ ァ イル形式があ り ます。 殆どの作業でステ ッ プ １ （対象フ ァ イル入力）、 ステ ッ プ ３ （出力フ ァ イル
名と フ ォルダーの指定）、 およびステ ッ プ ４ （フ ァ イル生成 ・ 実行） は共通の操作にな り ます。 ステ ッ プの進
行はそれぞれウ ィ ン ド ウ下部の 『Next』 ボ タ ンで行います。 戻る場合は 『Previous』 ボ タ ン を ク リ ッ ク し ま
す。 開始画面には戻れませんが、 ステ ッ プ １ までは戻る こ と ができ ます。

15.1.2 jedec から hex への変換

　 しばしば jedec フ ァ イルを 16 進表記にし て確認 ・ 作業する必要があ る場合があ り ます。 デプロ イ メ ン ト ・
ツールではこ の変換が容易にでき ます。 起動後、 最初のウ ィ ン ド ウで、 「Function Type」 と し て ”File Con-  
version” を、 「Output File Type」 と し て ”JEDEC to Hex” を選択し て 『OK』 を ク リ ッ ク し ます

図 15-3. jedec から hex 変換の開始

　 次にステ ッ プ １ で対象のフ ァ イルをブラ ウ ズ し て指定し ます （図 15-4）。

図 15-4. 対象フ ァ イルの指定

　 ステ ッ プ ２ は出力フ ォーマ ッ ト の指定です （図 15-5）。 通常は ”ASCII Row Hex” です。

図 15-5. 出力フ ォーマ ッ ト の確認

　 ステ ッ プ ３ は出力フ ァ イル名と フ ォルダーの指定です （図 15-6）。

図 15-6. 出力フ ァ イル名 と フ ォルダーの指定
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　 ステ ッ プ ４ がフ ァ イル生成・実行です（図 15-7）。上部のア イ コ ン を ク リ ッ クするか、右下の『Generate』

ボタ ンを ク リ ッ ク し ます。 ステータ ス窓で ”... successfully.” と なっている こ と を確認し て終了し ます。

図 15-7. 変換実行 と結果確認

15.1.3 デュ アルブー ト 用 mcs フ ァ イル生成 ： ECP5、 Crosslink

　 ECP5 フ ァ ミ リ ーと Crosslink が対応するデュ アルブー ト 機能用に、 外付け SPI フ ラ ッ シュ メ モ リ ーにス ト
アする二本のビ ッ ト ス ト リ ーム ・ フ ァ イルを結合し て *.mcs フ ァ イルを生成し ます。デュ アルブー ト 機能は、
CRC エラーなど何らかの理由で ” プラ イマ リ ” ビ ッ ト ス ト リ ームでの起動に失敗する と、自律的に ” ゴール
デン ” ビ ッ ト ス ト リ ームで再起動を試みる ものです。

図 15-8. デュ アルブー ト 用フ ァ イル生成の開始

　 まず最初のウ ィ ン ド ウで、 「Function Type」 と し て ”External Memory” を、 「Output File Type」 と し て ”Dual    
Boot” を選択し て 『OK』 を ク リ ッ ク し ます （図 15-8）。
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図 15-9. ビ ッ ト ス ト リ ーム ・ フ ァ イル 2 本の指定例

　 次に使用する フ ァ イルの指定ウ ィ ン ド ウが表れます （図 15-9）。 生成済みの .bit フ ァ イルをブラ ウズ し て 
入力し ます。 上がゴールデン、 下がプラ イマ リ です。 『Next』 ボタ ンを ク リ ッ ク し て進みます。

　 次のウ ィ ン ド ウは生成する フ ァ イルのオプシ ョ ン設定です （図 15-10） 。 「Output Format」 は Intel Hex、   
Motorola Hex、 Extended Tektronix Hex から選択し ます。 通常は Intel Hex です （拡張子 mcs）。 フ ラ ッ シュ メ    
モ リ ーのサイ ズを選択し、 ゴールデン と プラ イマ リ が正しいこ と を確認し ます。 その下に 4 つのオプシ ョ ン
があ り ます。

• Protect Golden Sector ゴールデンに保護を掛けます （万が一のため、 オンにし ておき ます）

• Byte Wide Bit Mirror ビ ッ ト 反転。 Hex フ ァ イル出力では基本的に反転ですのでチェ ッ ク し ます

• Retain Bitstream Header ヘッ ダ情報を保持する場合にチェ ッ ク し ます。 通常は残し ます （オフ）

• Optimize Memory Space SPI フ ラ ッ シュ メ モ リ ーのサイ ズに余裕がない場合です。 オンにし なければ
いけない状況は推奨し ません

　 通常は図 15-10 の例のよ う にゴールデンの保護 と ビ ッ ト 反転 （ ミ ラー リ ング） をオンにし、 『Next』 ボタ 
ンを押し て次に進みます。 「SPI Flash Read Mode」 はデフ ォル ト が ”Standard Read” です。 第 15.1.5 項に記述    
する、 リ ードデータ線を複数とする ”Dual/Quad SPI リ ード ” の場合は ”Dual (Quad) I/O SPI Flash Read” を選      
択し ます。

図 15-10. 生成フ ァ イルのオプシ ョ ン指定例

　 生成フ ァ イル （拡張子 .mcs） と フ ォルダー位置の確認・指定ウ ィ ン ド ウが表示されますので入力し （図 15- 
11）、 右下の 『Next』 ボタ ンを ク リ ッ ク し ます （図 15-11 では割愛）。
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図 15-11. フ ァ イル名 と フ ォルダー指定例

　 次にフ ァ イル生成し ます。右下の『Generate』ボタ ンを ク リ ッ クするか、上部のア イ コ ン を ク リ ッ ク し ま

す。 ウ ィ ン ド ウ下部のコ ン ソールに ”... successfully” と ロ グ表示されれば正常終了です ( 図 15-12)。

　 右上の 『View File』 ボタ ンを ク リ ッ クする と、 テキス ト ビ ューアーが立ち上が り 、 生成し たフ ァ イルが閲

覧でき ます。 また ア イ コ ンを ク リ ッ クする など し て ロ グフ ァ イルをチェ ッ ク （保存） する こ と を推奨し

ます。 ジ ャ ンプコマン ド、 プ ラ イ マ リ と ゴールデン両ビ ッ ト ス ト リ ームの開始 ・ 終了ア ド レ ス （セ ク ター）
情報が書き出されています。 特に開始セ ク ター （ア ド レ ス） は一方のビ ッ ト ス ト リ ームのみを更新し て書き
換え る場合に必要と な り ます。 デバイ ス ・ フ ァ ミ リ ー毎に両ビ ッ ト ス ト リ ーム と ジ ャ ンプコマン ド のセ ク タ
は決められています。 デプロ イ メ ン ト ツールは自動的に対処し て く れますが、 ユーザーが何らかの別の手段
で生成する場合は注意が必要です。

図 15-12. フ ァ イル生成 と チェ ッ ク

　 　 デプロ イ メ ン ト ・ ツールの終了は、 ウ ィ ン ド ウ右上隅の ”X” 印を ク リ ッ ク し ますが、 プロ ジェ ク ト フ ァ
イル （拡張子 .ddt） を保存するかど う かの確認を促されます。 保存し ておけば、 後で修正などの繰 り 返し作
業する場合などに有用です。

15.1.4 マルチブー ト 用 mcs フ ァ イル生成 ： ECP5

　 ECP5 フ ァ ミ リ ーは、最大四本までの代替えビ ッ ト ス ト リ ーム ・ フ ァ イルを外付け SPI フ ラ ッ シュ メ モ リ ー
に格納し、 それら を自律的に切 り 替え るマルチブー ト 機能があ り ます。 そのための mcs フ ァ イルを生成し ま
す。Dual Boot のよ う に出力フ ァ イルタ イプ と し ては定義されていませんので、図 15-13 のよ う に最初のウ ィ  
ン ド ウでは 「Function Type」 を ”External Memory”、 「Output File Type」 を ”Advanced SPI Flash” にし ます。
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図 15-13. マルチブー ト 用フ ァ イル作成の開始

図 15-14. マルチブー ト 用フ ァ イル作成 ： ステ ッ プ １

　 次のステ ッ プ １ （図 15-14） では ” ゴールデン ” ビ ッ ト ス ト リ ーム ・ フ ァ イルを指定し ます。 ステ ッ プ ２ 
で変更も可能です。 指定後、 ウ ィ ン ド ウ下部の 『Next』 ボタ ンで次に進みます。

図 15-15. マルチブー ト 用フ ァ イル作成 ： ステ ッ プ ２
15-6 Lattice Diamond プログラ ミ ング ・ ユーテ ィ リ テ ィ
©2021 Macnica, Inc.



Rev.3.12
　 ステ ッ プ ２ ではマルチブー ト ・ モード の指定、 ビ ッ ト ス ト リ ーム ・ フ ァ イルの指定を行います （図 15-15）。 
タブ [Multiple Boot] を選択し て最上部の 「Multiple Boot」 チェ ッ ク ボ ッ ク ス をチェ ッ ク し て イネーブルし ま  
す。 「Number of Alternate Patterns」 のプルダウ ン （2 ～ 4） から ゴールデン以外のパターン数を指定し、 ぞれ   
ぞれのセルに対し てフ ァ イルをブ ラ ウ ズ し て指定し ます。 ゴールデンにはス テ ッ プ １ で与えたフ ァ イルが
入っていますので、 このステ ッ プで変更する こ と も可能です。

　 指定パターン数に対し て SPI フ ラ ッ シュ メ モ リ ーのサイ ズが不足する場合は、 ウ ォーニング ・ メ ッ セージ
が表示されますので、 [Options] タブを選択し て 「SPI Flash Size」 部を適宜変更し ます。 「Starting Address」 は   
特段の理由がない限 り 変更し ないこ と を推奨し ます。

　 この後のステ ッ プはデュ アルブー ト と同様です （図 15-11、 図 15-12）。

15.1.5 Dual/Quad SPI リ ード用 mcs フ ァ イル生成 ： ECP5

　 ECP5 フ ァ ミ リ ーは、 MASTER SPI イ ン ターフ ェ イ スで外付け SPI フ ラ ッ シュ メ モ リ ーから コ ンフ ィ グレー 
シ ョ ンする際に、 データ線を二本 （Dual） または四本 （Quad） にする こ と ができ ます （Dual/Quad SPI リ ー 
ド）。 この場合にも SPI フ ラ ッ シ ュ メ モ リ ーに格納する ビ ッ ト ス ト リ ーム ・ フ ァ イルは単独ですが、 やは り デ
プロ イ メ ン ト ・ ツールで mcs に変換し ます。

　 作業開始のウ ィ ン ド ウ ではマルチブー ト と 同様で、 「Function Type」 を ”External Memory”、 「Output File   
Type」 を ”Advanced SPI Flash” にし ます ( 図 15-16)。 次のステ ッ プ １ でのフ ァ イル指定も同じです。

　 異な るのはステ ッ プ ２ で、 のよ う に 「SPI Flash Read Mode」 を ”Dual (Quad) I/O SPI Flash Read” にし ます。

図 15-16. Dual/Quad SPI リ ード用フ ァ イル作成 ： ステ ッ プ ２

　 ステ ッ プ ３ と ４ はデュ アルブー ト と同様です。

15.1.6 MSPI/SSPI デイ ジーチェ イ ン対応 SPI 用 mcs フ ァ イルの生成 ： ECP5

　 ECP5 には種々コ ンフ ィ グレーシ ョ ン ・ モード があ り ますが、 図 15-17 のよ う に MSPI モード の ECP5 を先 
頭にし て SSPI モード の ECP5 を複数個、 同一チェ イ ンにする構成 （デイ ジーチェ イ ン） があ り 得ます （各信
号線にはプルア ッ プ / ダウ ン抵抗が必要ですが割愛し ています。 DONE/INITn 信号線は Wired-OR 接続し て
います）。 この場合に SPI フ ラ ッ シ ュ メ モ リ ーには各デバイ スのビ ッ ト ス ト リ ーム ・ フ ァ イルを結合し た mcs
フ ァ イルを格納し、 これはデプロ イ メ ン ト ・ ツールで作成し ます。

　 なお、 本構成での各ビ ッ ト ス ト リ ーム ・ フ ァ イルの作成は、 Diamond において次のよ う な設定が必要です。

・ SPI フ ラ ッ シ ュ メ モ リ を接続する先頭の ECP5 はスプレ ッ ド シー ト ・ ビ ュー [Global Preferenecs] タ 
ブの sysCONFIG セ ク シ ョ ンで、 MASPTER_SPI_PORT=ENABLE、 DONE_EX=ON にし ます

・ 二個目以降の ECP5 はスプレ ッ ド シー ト ・ ビ ュー [Global Preferenecs] タブの sysCONFIG セ ク シ ョ 
ンで、 SLAVE_SPI_PORT=ENABLE、 DONE_EX=ON にし ます

・ ア ク テ ィ ブなス ト ラ テジー設定を立ち上げ、 ”Bitstream” プロセスの ”Chain Mode” オプシ ョ ンを全
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　 てのデバイ スで [Bypass] にし ます

　 以上の設定でそれぞれ ”Export Files” プロセス まで実行し てビ ッ ト ス ト リ ーム ・ フ ァ イルを生成し ます。そ 
の後、 これら フ ァ イルに対し て第 15.4 節に記述する操作で MCLKB ビ ッ ト を編集し ます。 これら手順で準備
し た対象フ ァ イルを用いて次のステ ッ プ以降を行います。

　 デプロ イ メ ン ト ・ ツールでの開始はマルチブー ト と同じ よ う に （図 15-13）、 「Function Type」 を ”External  
Memory”、 「Output File Type」 を ”Advanced SPI Flash” にし ます。 ステ ッ プ １ のフ ァ イル指定も図 15-14 と同     
様ですが、 これには先頭の MSPI モード の ECP5 用ビ ッ ト ス ト リ ーム ・ フ ァ イルを与えます。

図 15-17. ECP5 の MSPI/SSPI デイ ジーチェ イ ン構成例

　 ステ ッ プ ２ が各フ ァ イルの指定など詳細設定です （図 15-18）。 [User Data Files] タブで 「User Data Files」     
ボ ッ ク ス と 「Byte Wide Bit Mirroring」 ボ ッ ク ス を共にチェ ッ ク し ます。 「Number of User Data Files」 プルダ       
ウ ンを操作し、 SSPI モード のデバイ ス数に一致する値にし ます。 値に相当する各フ ィ ール ド がア ク テ ィ ブに
な り ますので、 それぞれブラ ウズ ・ ボタ ンを ク リ ッ ク し て適切なビ ッ ト ス ト リ ーム ・ フ ァ イルを指定し ます。

図 15-18. MSPI/SSPI チェ イ ン用 mcs 生成のステ ッ プ ２ の例

　 「Starting Address」 各セルは自動的に値が入 り ますので、 ユーザーが編集する必要はあ り ません。

　 [Options] タブ （図 15-18 では図示し ていません） の 「SPI Flash Size」 部で SPI フ ラ ッ シ ュ メ モ リ ーのサイ
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ズを指定し ますが、 全フ ァ イルのサイ ズに対し て SPI フ ラ ッ シ ュ メ モ リ ーが小さい場合は、 ウ ォーニング ・
メ ッ セージが表示されますので、 適宜変更し ます。

　 また、 [Options] タブ内にも 「Byte Wide Bit Mirror」 オプシ ョ ンがあ り ますが、 こ ち らはチェ ッ ク し ないで   
おき ます。 次のステ ッ プ ３ の出力フ ァ イル名の設定と ステ ッ プ ４ ”Generate” は他と同様です。

15.1.7 ビ ッ ト ス ト リ ーム ・ フ ァ イルの暗号化

　 ビ ッ ト ス ト リ ーム ・ フ ァ イルの暗号化を実行するには通常の Diamond パッ ケージに加えて暗号化機能用の
パッ ケージ （Encryption Package） が必要です （第 14.6.1 項に関連記述があ り ますので、 ご参照 く ださい） 。 
暗号化パッ ケージを イ ン ス ト ールし ていない と。 本節で示すよ う なス ク リ ーン ・ ダンプ例が得られませんの
でご留意 く ださい。

　 作業手順は次の通 り です。 まずデプロ イ メ ン ト ツールを起動し、 「Function Type」 は ”File Conversion” に、  
「Output File Type」 は ”Bitstream” を選択し ます （図 15-19）。 既に作成済みデプロ イ メ ン ト ツール ・ プロ ジェ   
ク ト があれば、 下部の 『Open an Existing Deploym』 をチェ ッ ク し て ddt フ ァ イルをブラ ウズする こ と で指定   
し ます。 『OK』 ボタ ンを ク リ ッ ク し ます。

図 15-19. 暗号化ステ ッ プの開始

　 次のステ ッ プは暗号化対象フ ァ イルの指定ですが、 これは他と同様の方法でブラ ウズ し て 『Next』 ボタ ン
で進みます。 次のステ ッ プ ２ はオプシ ョ ンの詳細設定です （図 15-20）。

図 15-20. 暗号化のステ ッ プ ２
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　 最下部の 「Encryption」 ボ ッ ク ス をチェ ッ ク し て有効にし て暗号化キーを入力し ます。 『Load Key』 ボタ ン 
を ク リ ッ ク し て表示される フ ァ イル ・ ブ ラ ウザのウ ィ ン ド ウで暗号化キーフ ァ イル （.bek） を指定する と、
図 15-20 内の小ウ ィ ン ド ウが表示されますので、 暗号化キーフ ァ イルのパス ワード を入力し ます。 パス ワー 
ド が一致すれば、 『OK』 を ク リ ッ ク し て抜けた後に 「Encryption Key」 セルが ” ● ” で満た されます。 『Next』 
ボタ ンで次に進みます。

　 パス ワード が一致し ない と このステ ッ プを完了でき ませんので、 ご注意下さい。 また 「Encryption Key」 セ 
ルを直接編集する こ とやパス ワード の変更などはでき ません。 パス ワード の設定と暗号化キーフ ァ イルの生
成は Diamond の ”Security Tool” で行います。 第 14.6.3 項をご参照下さい。

　 ステ ッ プ ３ は出力フ ァ イル名と場所の指定です （図 15-21）。 暗号化し た こ と が容易に判別でき る名称にす 
る よ う にし ます。 『Next』 で次に進みます。

図 15-21. 暗号化ステ ッ プ ３

　 ステ ッ プの最後が暗号化ビ ッ ト ス ト リ ームの生成です。 右下の 『Generate』 ボタ ンか上部の ア イ コ ン

を ク リ ッ ク し ます。 他と同様に ”... excited successfully” と表示されれば正常終了です。

15.1.8 SPI フ ラ ッ シ ュ メ モ リ ー内にユーザーデータ を共存

　 外付け SPI フ ラ ッ シ ュ メ モ リ ー内に、 コ ンフ ィ グレーシ ョ ンデータ と ユーザーデータ を共存する こ と が可
能です。 この場合、 特段に留意するべき事項はあ り ませんが、 以下の基本的な点を押さ えておき ます。

• 使用するデバイ ス （フ ァ ミ リ ーと規模） によ ってビ ッ ト ス ト リ ーム ・ フ ァ イルや、 デュ アルブー ト 時
のジ ャ ンプコマン ド の開始ア ド レ スは一義的に決ま るセ ク ターは避ける

• バイナ リ かテキス ト （Hex) フ ァ イルかで LSB - MSB 順が逆にな る

• デバイ スによ っては SPI ア ク セスの信号線はコ ンフ ィ グレーシ ョ ン用ポー ト が共用できないため、 注
意深 く ピン配置を行 う

　 SPI フ ラ ッ シ ュ メ モ リ ーのユーザーデータにア ク セスするための手段は、 ユーザーが用意し ます。 共存さ
せるためのツール と し てデプロ イ メ ン ト ・ ツールが使用でき ます。 MSPI/SSPI チェ イ ンの場合と同様の手順
ですが、 図 15-18 においてビ ッ ト ス ト リ ーム ・ フ ァ イルではな く 、 意図するユーザーデータ を指定し ます。 
また、 開始ア ド レ スの変更はユーザー依存です。

15.2 フ ィ ーチャー行エデ ィ ター （MachXO2/XO3L/XO3LF）
　 注 ： フ ィ ーチャー行のみの意図的な変更は開発時 （及び量産出荷時） に限る こ と を強 く 推奨し ています。

　 ハード マ ク ロ EFB がサポー ト する I2C や SPI イ ン ターフ ェ イ ス を介し て、 外部コ ン ト ローラから最初に
（デバイ スがブラ ン ク時や消去状態で） プロ グ ラ ミ ングする際には、 フ ィ ーチャー行 （Feature Row） は通常 
最低一度はア ク セス （ラ イ ト ） する こ と にな り ます。 こ れは、 特にフ ィ ーチャー行は使用可能にする コ ン 
フ ィ グレーシ ョ  ン ・ ポー ト の制御を行 う ためです。

　 何らかのやむを得ない事由 （含デバッ グ等） でフ ィ ーチャー行に書かれている ビ ッ ト の設定値を確認し た
り 、 編集する こ と が避け られない場合はフ ィ ーチャー行エデ ィ ターが活用でき ます。 起動するには、 デタ ッ
チし たプロ グ ラ マーで Design → Utilities → Programming File Utility を順に選択し てユーテ ィ リ テ ィ ・ツールを  
立ち下げ （図 15-22）、 その後 Tools → Feature Row Editor を指定し て行います。 また Programming File Utility
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については、 図 15-1 に示すと同様の手順で Windows のス ター ト メ ニ ューから立ち上げる こ と もでき ます。

図 15-22. フ ィ ーチャー行エデ ィ ターの起動

　 起動後、 まず①ブラ ウズボタ ンで jed フ ァ イルをブラ ウズ後に指定し ます。次に② 『Read』 ボタ ンを ク リ ッ
クする こ と でフ ァ イルから フ ィ ーチャー行情報を抽出する と、 図 15-23 のよ う に表示されます。

図 15-23. フ ィ ーチャー行エデ ィ ター、 jedec リ ード後の表示例 （MachXO3L）

　 MachXO3D の場合は <xxx_a.jed><xxx_b.jed> フ ァ イルではな く 、 <xxx.fea> フ ァ イルを対象に指定し ます。 表
示される ウ ィ ン ド ウは図 15-23 と はやや異な り ます。

　 黒色で表記されている ビ ッ ト のいずれかを ク リ ッ クするたびに、 当該ビ ッ ト 表示が ト グルし ます。 赤色表
記のビ ッ ト は編集でき ません。 編集後、 ③ 『Save As』 で Jedec フ ァ イル と し て別名で保存し ます。

　 なお、 フ ィ ーチャー行エデ ィ ターでは、第 16.3.2 項で記述する TraceID および Custom ID Code の編集がで  
き ます。 図 15-23 の中に含まれている こ と が理解でき ます。
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　 意図せず不明瞭な理解に基づ く ア ク セス を行 う と、不適切な値に書き換えて し まい（ア ク テ ィ ブなコ ンフ ィ
グレーシ ョ ン ・ ポー ト が使用でき な く な り ）、結果的にその後のア ッ プデー ト を行えな く なる状態になる可能
性が否定でき ません。 注意の上に注意が必要です。

15.3 USERCODE エデ ィ ター
　 特にユーザーコード に限定し て編集する ツールが USERCODE エデ ィ ターです。 起動は図 15-24 のよ う に 
[Tools] → [USERCODE Editor...] を選択し ます。

　 表示される ウ ィ ン ド ウの右上 「Device」 行右端のブラ ウ ズボタ ンで、 意図する ビ ッ ト ス ト リ ーム ・ フ ァ イ
ルを指定し ます。 デバイ ス タ イプが読み込まれ、 表示に反映されます （図 15-24 右下）。 『Read』 ボタ ンを ク 
リ ッ ク し て値を抽出し て表示し ます （図 15-24 左下）。 これで所望の値に編集し、 『Save As』 で別名保存し ま  
す。 デフ ォル ト では 16 進表記になっていますが、 選択が可能です。

図 15-24. USERCODE エデ ィ ターの起動から編集までの例

15.4 コ ン ト ロール ・ レジス タ ０ エデ ィ ター
　 第 15.1.6 項で記述し た ECP5 MSPI/SSPI デイ ジーチェ イ ン ・ コ ンフ ィ グレーシ ョ ン用の mcs フ ァ イル生成 
に関連し て、チェ イ ンに接続される全ての ECP5 は、 このコ ン ト ロール・ レジス タ ０ エデ ィ ターを用いてビ ッ
ト ス ト リ ーム ・ フ ァ イルを編集する必要があ り ます。

　 それ以外でユーザーが用いる必要があ る ケースは特に認識されていません。

図 15-25. コ ン ト ロール ・ レジス タ ０ エデ ィ ターの起動

　 起動は Tools → Control Register0 Editor... と選択し ます （図 15-25）。

　 起動後、 まず①ブラ ウズボタ ンで bit フ ァ イルをブラ ウズ後に指定し ます。 次に② 『Read』 ボタ ンを ク リ ッ
クする こ と で図 15-26 のよ う にフ ァ イルから情報が抽出され表示されます。 黒色で表記されている ビ ッ ト の 
いづれかを ク リ ッ クするたびに、 当該ビ ッ ト 表示が ト グルし ます。 赤色表記のビ ッ ト は編集でき ません。 編
集後、 ③ 『Save As』 で bit フ ァ イルを別名で保存し ます。

　 　 ECP5 MSPI/SSPI チェ イ ンの構成時は、 ”MCLKB” ビ ッ ト を ’1’ に変更する必要があ り ます。 編集後の 
ビ ッ ト フ ァ イルが、mcs フ ァ イル と し て結合する対象です。『Save』 または 『Save As』 で保存し て使用し ます。
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図 15-26. コ ン ト ロール ・ レジス タ ０ エデ ィ ターの作業例 （ECP5）

15.5 ダウ ン ロード ・ デバッ ガー
　 何らかの理由で JTAG プロ グ ラ ミ ングが失敗する場合、いったん書き込みフ ァ イル （.bit、.jed） を SVF フ ァ
イルに変換し、これを用いてデバッ グを実行する こ と によ って原因を究明でき る場合があ り ます。ダウ ン ロー
ド ・ デバッ ガー （Download Debugger） は、 ダウ ン ロード ケーブルで接続された実デバイ ス を動作させながら、 
SVF フ ァ イルを実行するためのツールです。 ”svf (serial vector format)” は元来 PCB テス ターで用いられる書   
式です。

図 15-27. デプロ イ メ ン ト ツールのフ ァ ン ク シ ョ ン タ イプ選択

　 SVF フ ァ イルを未生成の場合、 まずデプロ イ メ ン ト ツールでフ ォーマ ッ ト 変換し ます。 「Function Type」 は 
”Tester”、 「Output File Type」 は ”SVF” を選択し ます （図 15-27）。 JTAG チェ イ ン内にターゲ ッ ト の単一デ   
バイ スのみでは ”SVF - Single Device” を、 ターゲ ッ ト を含む複数デバイ スの JTAG チェ イ ンの場合は ”SVF -    
JTAG Chain” です。

図 15-28. SVF 変換の各種オプシ ョ ン指定
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　 ステ ッ プ 1 でソース フ ァ イルを指定後、 ステ ッ プ 2 で図 15-28 のよ う にオペレーシ ョ ン （Operation) と各 
オプシ ョ ンを指定し ます。 選択でき るオペレーシ ョ ンはターゲ ッ ト デバイ スに依存し ます。

　 その後ステ ッ プ 3 で出力フ ァ イル名と フ ォルダーを指定し、 ステ ッ プ 4 で変換を実行 （Generate） し ます
（図 15-29） 。 ”... successfully” と 表示されれば終了です。 作業を繰 り 返す際に備えてデプロ イ メ ン ト ・ プロ  
ジェ ク ト （.ddt） と し て保存し ておき ます。

図 15-29. SVF フ ァ イルの生成 ・ 変換例

　 以上で準備が整いま し たのでダウ ン ロード ・ デバッ ガーを起動し ます。 図 15-29 中の右上にあ る 『Launch 
Debugger』 を ク リ ッ クする こ と で連続し て作業ができ ます。 表示は生成し た SVF を ロード し た状態で立ち上
が り 、 ブレーク ポイ ン ト を設定し た り でき る よ う にな り ます （図 15-31）。

　 または一度デプロ イ メ ン ト ・ ツールを終了し、 図 15-30 のよ う に、 プロ グ ラマーから起動する こ と も可能 
です。 こ の場合、 何も フ ァ イルを ロー ド し ていないブラ ン ク状態でデバ ッ ガーが立ち上が り ますので、 File
→ Open と たど り デバッ グのターゲ ッ ト とする SVF フ ァ イル （別作業の場合は STP、 VME フ ァ イルなどが選
択可） を指定し ます。 これによ り 、 図 15-31 のよ う な初期状態にな り ます。

図 15-30. プロ グ ラ マーから ダウ ン ロード ・ デバッ ガーを起動

　 デバ ッ ガーの操作は、 組み込みソ フ ト ウ ェ アをデバ ッ グする際のプ リ ミ テ ィ ブな手法 と 類似し ています。
上部にあ る ア イ コ ン列を活用し てステ ッ プ実行、 ブレーク ポイ ン ト の設定 ・ 解除、 ブレーク ポイ ン ト までの
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実行、 などを行います。 ア イ コ ン と オペレーシ ョ ンは図中に示す通 り です。

図 15-31. SVF デバッ ガー表示例

　 なお、 チェ イ ン内に複数のデバイ スがあ る場合はオプシ ョ ン設定が必要です。 ア イ コ ンを ク リ ッ クす

るか、 ダウ ン ロード ・ デバッ ガーの メ ニューで Debugger → Options... と たど り 、 SVF タブを設定する こ と で
オプシ ョ ン設定画面を表示させます

図 15-32. SVF オプシ ョ ン設定
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　 JTAG チェ イ ン内にあ る ターゲ ッ ト ・デバイ ス をデバッ グする場合、前 （header：ヘッ ダー） と後ろ （trailer：
ト レ イ ラー） にあ るデバイ スの命令レジス タ （Instruction Register） 長 [ 単位 ： bit] を指定し ます （図 15-32、  
赤枠）。 ない場合は 0 です。 図 15-33 にヘッダー長、トレイラー長の設定例を示します。

図 15-33. JTAG チェ イ ンの構成 と レジス タ長の例

--- *** ---
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